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This document contains information about calibrating National
Instruments 9235/9236 modules using NI-DAQmx. This calibration
procedure is intended for metrology labs.
This document does not discuss programming techniques or compiler
configuration. The NI-DAQmx driver contains online help files that have
compiler-specific instructions and detailed function explanations. You can
install these help files when you install NI-DAQmx on the calibration
computer.
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Conventions
The following conventions appear in this manual:
»

The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options directs you to
pull down the File menu, select the Page Setup item, and select Options
from the last dialog box.
This icon denotes a note, which alerts you to important information.

bold

Bold text denotes items that you must select or click in the software, such
as menu items and dialog box options. Bold text also denotes parameter
names and hardware labels.

italic

Italic text denotes variables, emphasis, a cross-reference, or an introduction
to a key concept. Italic text also denotes text that is a placeholder for a word
or value that you must supply.

monospace

Monospace text denotes text or characters that you should enter from the
keyboard, sections of code, programming examples, and syntax examples.
This font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, operations,
variables, filenames, and extensions.

monospace italic

Italic text in this font denotes text that is a placeholder for a word or value
that you must supply.

Software
Install NI-DAQmx 8.8 or later on the calibration computer. NI-DAQmx
includes high-level function calls to simplify the task of writing software to
calibrate devices. You must have the proper device driver installed on the
calibration system before calibrating the device.
NI recommends that you install the NI-DAQmx driver software before physically
installing the NI 9235/9236. NI-DAQmx, available at ni.com/downloads, configures
and controls the NI 9235/9236.

Note

NI-DAQmx supports a number of programming languages, including
LabVIEW, LabWindows™/CVI™, Microsoft Visual C++ 6.0, Microsoft
Visual Basic 6.0, Microsoft .NET, and Borland C++.
You can access the NI-DAQmx header file, NIDAQmx.h, like any standard
library. You can find examples of how to use the NI-DAQmx driver in the
Program Files\National Instruments\NI-DAQ\Examples

directory.
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Documentation
You might find the following documentation helpful as you write the
calibration procedure:
•

NI-DAQmx Help—This help file contains general information about
measurement concepts, key NI-DAQmx concepts, and common
applications that apply to all programming environments. To access
this help file, select Start»All Programs»National Instruments»
NI-DAQ»NI-DAQmx Help.

•

NI-DAQmx C Reference Help—This help file contains C reference and
general information about measurement concepts. To access this help
file, select Start»All Programs»National Instruments»NI-DAQ»
NI-DAQmx C Reference Help.

•

DAQ Getting Started guides for NI-DAQ 8.0 or later—This guide
describes how to install NI-DAQmx for Windows software and
NI-DAQmx-supported DAQ devices, and how to confirm that your
device is operating properly. To access this guide, select Start»
All Programs»National Instruments»NI-DAQ»DAQ Getting
Started Guide.

The documents above are installed with NI-DAQmx. You can also download the
latest versions from the NI Web site at ni.com/manuals.

Note

•

NI 9235/9236 Operating Instructions and Specifications—This
document describes how to use the NI 9235/9236 and includes
specifications and terminal assignments for the NI 9235/9236. The
limits you use to verify the accuracy of the devices are based on the
specifications found in this document. You can download the latest
version of this document from the NI Web site at ni.com/manuals.

Calibration Interval
The NI 9235/9236 should be calibrated at a regular interval as defined by
the measurement accuracy requirements of your application. National
Instruments recommends that you routinely perform a complete calibration
at least once every year. You can shorten this interval based on the accuracy
demands of your application or requirements of your processes.
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Test Equipment
National Instruments recommends that you use the following equipment
for calibrating the NI 9235/9236.
Table 1. Recommended Equipment

Equipment
Calibrator

Recommended Model

Requirements

Fluke 5500A

If this instrument is unavailable, use a calibrator with
generation of resistances in the ranges of 108 Ω – 132 Ω
and 315 Ω – 385 Ω with 0.01 Ω resolution, an accuracy
of at least 90 ppm, and automatic lead wire
compensation.

DMM

NI 4070

Chassis

NI cDAQ chassis

—

—

Connections between the module and the calibrator are
insensitive to connection resistance except between the
calibrator LO terminal and the module RC terminal. The
resistance of this connection must be less than 200 mΩ to
limit bridge linearity errors. The verification test limits in
Tables 5 and 6 assume this requirement is met.

Connecting
wires

If this instrument is unavailable, use a multi-ranging
6 1/2 digit DMM with an accuracy of at least 40 ppm.

Test Conditions
Follow these guidelines to optimize the connections and the environment:
•

Keep connections to the device as short as possible. Long cables and
wires act as antennae, picking up extra noise that can affect
measurements.

•

Use shielded copper wire for all cable connections to the device.
Use twisted-pair wire to eliminate noise and thermal offsets.

•

Maintain an ambient temperature of 23 ±5 °C. The device temperature
will be greater than the ambient temperature.

•

Keep relative humidity below 80%.

•

Allow a warm-up time of at least 10 minutes to ensure that the
measurement circuitry is at a stable operating temperature.
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Calibration Procedure
This section provides instructions for verifying the performance of the
NI 9235/9236.

Calibration Process Overview
The calibration process consists of the following steps:
1.

Initial Setup—Configure the device in NI-DAQmx.

2.

Verification Procedures—Verify the existing operation of the device.
This step confirms whether the device is operating within its specified
range and whether it needs adjustment.

3.

Adjustment—If the device does not fall within the desired
specifications, submit the device to NI for a factory calibration to
adjust the calibration constants.

4.

Verification Procedures—Perform another verification to ensure that
the device operates within its specifications after adjustment.

The first two steps are explained in the following sections.

Initial Setup
You must configure the device in Measurement & Automation Explorer
(MAX) to communicate with NI-DAQmx.
Complete the following steps to configure a device in MAX:
1.

Install the NI-DAQmx driver software.

2.

Make sure that no power is connected to the module terminals. If the
system is in a nonhazardous location, the chassis power can be on
when you install the module.

3.

Insert the module into an available slot in the cDAQ chassis.

4.

Launch MAX.

5.

Right-click the device name and select Self-Test to ensure that the
device is working properly.

Note When a device is configured with MAX, it is assigned a device name. Each function
call uses this device name to determine which DAQ device to calibrate. This document uses
dev1 to refer to the device name. In the following procedures, use the device name as it
appears in MAX.
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Connecting the Calibrator to the Module
Complete the following steps to connect the calibrator to the module for
both the measurement accuracy verification and the shunt calibration
verification:
1.

Set the calibrator to standby mode (STBY).

2.

Connect the AUX LO terminal of the calibrator to the LO terminal of
the calibrator.

3.

Using discrete connections, connect the LO terminal of the calibrator
to the AI and RC terminals of the module channel you want to verify.
Leave all other channels unconnected.

The three connections to the calibrator LO terminal must be connected at the
calibrator output jack.

Note

Note Ensure that the connection resistance between the calibrator LO terminal and the
module RC terminal meets the requirement listed in Table 1.

4.

Connect the HI terminal of the calibrator to the EXC0 terminal of the
module.

5.

Connect the AUX HI terminal of the calibrator to the EXC1 terminal
of the module.

You do not have to change the EXC terminal connections for each channel you
verify, because the EXC terminals all connect to a common excitation supply inside the
NI 9235/9236.

Note
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Refer to Figure 1 for an illustration of the calibrator to module connections.

Fluke
5500A

AUX HI

EXC1

HI

EXC0

LO

AI0

AUX LO

RC0

NI 9235/9236

Figure 1. Calibrator to Module Connections

Refer to Figure 2 for the terminal assignments of the NI 9235/9236.

EXC0
AI0
RC0
EXC2
AI2
RC2
EXC4
AI4
RC4
EXC6
AI6
RC6

1 13
2 14
3 15
4 16
5 17
6 18
7 19
8 20
9 21
10 22
11 23
12 24

EXC1
AI1
RC1
EXC3
AI3
RC3
EXC5
AI5
RC5
EXC7
AI7
RC7

Figure 2. NI 9235/9236 Terminal Assignments
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6.

Set the calibrator resistance output to 120 Ω for the NI 9235 or 350 Ω
for the NI 9236.

7.

Set the calibrator to operate mode (OPR).

8.

Wait one minute to allow the bridge elements formed by the calibrator
and the module completion resistor to thermally stabilize.

Verification Procedures
Verification determines how well the device is meeting its specifications.
By completing this procedure, you can see how the device has drifted over
time, which helps you determine the appropriate calibration interval for
your application. The NI 9235/9236 has eight independent analog input
channels. You can conduct verification on any or all of them, depending
upon your desired test coverage.
You can verify the following for NI 9235/9236 modules:
•

measurement accuracy

•

shunt calibration accuracy

•

excitation voltage

Measurement Accuracy Verification
Complete the following steps to test the measurement accuracy of the
device:
1.

Zero the calibrator with the ohms-only zero (OHMS ZERO) operation.
Refer to the calibrator documentation for more information about
zeroing the calibrator.

2.

Set the calibrator output for two-wire compensation (COMP 2-wire).
This automatically compensates for the lead wire resistance between
the HI terminal of the calibrator and the EXC terminal of the module.

3.

Connect the calibrator to the channel you want to verify, as explained
in the Connecting the Calibrator to the Module section.

4.

Set the calibrator resistance output to a Calibrator Output value
indicated in Table 5 for the NI 9235 and Table 6 for the NI 9236,
beginning with the 0 V/V nominal value.
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5.

If you use C function calls, create a task using DAQmxCreateTask,
as shown in the following table. If you use LabVIEW, skip this step.
The task is created in step 6 in LabVIEW.

LabVIEW Block Diagram

NI-DAQmx Function Call
Call DAQmxCreateTask with
the following parameters:

LabVIEW does not require this step.

taskName:
AIVerificationTask
taskHandle: &taskHandle

6.

Create and configure an AI Custom Voltage with Excitation channel using
the DAQmx Create Virtual Channel VI, as shown in the following table.

Throughout the procedure, refer to the NI-DAQmx function parameters for the
LabVIEW input values. Refer to the block diagram images for the correct instance to use
for polymorphic VIs.

Note

LabVIEW Block Diagram

NI-DAQmx Function Call
Call
DAQmxCreateAIVoltageChan
WithExcit with the following

parameters:
taskHandle: taskHandle
physicalChannel: dev1/aix*
nameToAssignToChannel:
myVoltageChannel

terminalConfig:
DAQmx_Val_Cfg_Default
minVal: –0.027
maxVal: 0.027
units: DAQmx_Val_Volts

bridgeConfig:
DAQmx_Val_QuarterBridge

voltageExcitSource:
DAQmx_Val_Internal

voltageExcitVal:
2.0 for the NI 9235
3.3 for the NI 9236
useExcitforScaling: TRUE
customScaleName: NULL
* x refers to the channel number.
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7.

Configure the timing properties for the acquisition using the DAQmx
Timing VI, as shown in the following table.

LabVIEW Block Diagram

NI-DAQmx Function Call
Call DAQmxCfgSampClkTiming
with the following parameters:
taskHandle: taskHandle
source: NULL
rate: 5000
sampleMode:
DAQmx_Val_FiniteSamps
sampsPerChan: 5000

8.

Turn off the shunt calibration for the channel using the DAQmx
Channel Property Node, as shown in the following table.

LabVIEW Block Diagram

NI-DAQmx Function Call
Call
DAQmxSetAIBridgeShuntCal
Enable with the following

parameters:
taskHandle: taskHandle
channel: NULL
data: FALSE
9.

Start the acquisition using the DAQmx Start Task VI, as shown in the
following table.

LabVIEW Block Diagram

NI-DAQmx Function Call
Call DAQmxStartTask with the
following parameter:
taskHandle: taskHandle
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10. Acquire 5,000 points of data using the DAQmx Read VI, as shown in
the following table.
LabVIEW Block Diagram

NI-DAQmx Function Call
Call DAQmxReadAnalogF64 with
the following parameters:
taskHandle: taskHandle
numSampsPerChan: –1
timeout: 10.0
fillMode:
DAQmx_Val_GroupByChannel
readArray: data
arraySizeInSamples: 5000
sampsPerChanRead: &read
reserved: NULL

11. Average the readings that you acquired and record the result.
12. Clear the acquisition using the DAQmx Clear Task VI, as shown in the
following table.
LabVIEW Block Diagram

NI-DAQmx Function Call
Call DAQmxClearTask with the
following parameter:
taskHandle: taskHandle

13. Repeat steps 4 through 12 for all calibrator output values.
NI recommends that you verify all values, although you can save time
by verifying only the values used in your application.
14. Perform the following calculation for each test result value other than
0 V/V, using the results you recorded in step 11.
Test Result – 0 V/V Test Result
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15. Compare the compensated result for each value to the Upper Limit
(V/V) and Lower Limit (V/V) values in Table 5 for the NI 9235 and
Table 6 for the NI 9236. If the result is between these values, the device
passes the test.
You can analyze data in V/V form or convert it to strain using the standard
quarter-bridge equation:

Note

–4 × Vr
strain ( ε ) = ------------------------------------------GF ( 1 + ( 2 × V r ) )
where Vr is the compensated reading from the NI 9235/9236 and GF is a gage factor of 2.
16. Repeat steps 3 through 15 for all channels.
17. Set the calibrator to standby mode (STBY).
18. Disconnect the calibrator from the device.

Shunt Calibration Accuracy Verification
Complete the following steps to test the shunt calibration accuracy of the
device:
1.

Using the DMM and 4-wire resistance measurement connections,
measure the resistance of the wire to be connected between the
calibrator LO terminal and the module RC terminal, and record the
result for later use. You must do this because this connection to the
module creates a lead wire desensitization error. This results in module
readings that are systematically lower than the true shunt calibration
output. Knowing the actual resistance value, however, allows for
compensation of this effect.

2.

Set the calibrator output for two-wire compensation (COMP 2-wire).
This automatically compensates for the lead wire resistance between
the HI terminal of the calibrator and the EXC terminal of the module.

3.

Connect the calibrator to the channel you want to verify, as explained
in the Connecting the Calibrator to the Module section.

4.

Set the calibrator resistance output to 120 Ω for the NI 9235 or 350 Ω
for the NI 9236.
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5.

If you use C function calls, create a task using DAQmxCreateTask,
as shown in the following table. If you use LabVIEW, skip this step.
The task is created in step 6 in LabVIEW.

LabVIEW Block Diagram

NI-DAQmx Function Call
Call DAQmxCreateTask with the following parameters:

LabVIEW does not require this step.

6.

taskName: SCVerificationTask
taskHandle: &taskHandle

Create and configure an AI Custom Voltage with Excitation channel
using the DAQmx Create Virtual Channel VI, as shown in the
following table.

Throughout the procedure, refer to the NI-DAQmx function parameters for the
LabVIEW input values. Refer to the block diagram images for the correct instance to use
for polymorphic VIs.

Note

LabVIEW Block Diagram

NI-DAQmx Function Call
Call
DAQmxCreateAIVoltageChan
WithExcit with the following

parameters:
taskHandle: taskHandle
physicalChannel: dev1/aix*
nameToAssignToChannel:
myVoltageChannel

terminalConfig:
DAQmx_Val_Cfg_Default
minVal: –0.027
maxVal: 0.027
units: DAQmx_Val_Volts

bridgeConfig:
DAQmx_Val_QuarterBridge

voltageExcitSource:
DAQmx_Val_Internal

voltageExcitVal:
2.0 for the NI 9235
3.3 for the NI 9236
useExcitforScaling: TRUE
customScaleName: NULL
* x refers to the channel number.
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7.

Configure the timing properties for the acquisition using the DAQmx
Timing VI, as shown in the following table.

LabVIEW Block Diagram

NI-DAQmx Function Call
Call DAQmxCfgSampClkTiming
with the following parameters:
taskHandle: taskHandle
source: NULL
rate: 5000
sampleMode:
DAQmx_Val_FiniteSamps
sampsPerChan: 10000

8.

Turn off the shunt calibration for the channel using the DAQmx
Channel Property Node, as shown in the following table.

LabVIEW Block Diagram

NI-DAQmx Function Call
Call
DAQmxSetAIBridgeShuntCal
Enable with the following

parameters:
taskHandle: taskHandle
channel: NULL
data: FALSE
9.

Start the acquisition using the DAQmx Start Task VI, as shown in the
following table.

LabVIEW Block Diagram

NI-DAQmx Function Call
Call DAQmxStartTask with the
following parameter:
taskHandle: taskHandle
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10. Acquire 10,000 points of data using the DAQmx Read VI, as shown in
the following table.
LabVIEW Block Diagram

NI-DAQmx Function Call
Call DAQmxReadAnalogF64 with
the following parameters:
taskHandle: taskHandle
numSampsPerChan: –1
timeout: 10.0
fillMode:
DAQmx_Val_GroupByChannel
readArray: data
arraySizeInSamples: 10000
sampsPerChanRead: &read
reserved: NULL

11. Average the readings that you acquired and record the result.
12. Clear the acquisition using the DAQmx Clear Task VI, as shown in the
following table.
LabVIEW Block Diagram

NI-DAQmx Function Call
Call DAQmxClearTask with the
following parameter:
taskHandle: taskHandle

13. Repeat steps 5 through 12, but this time in step 8 set the
AIBridgeShuntCalEnable property to TRUE to enable shunt
calibration for the channel.
14. Perform the following calculation using the results you recorded in
step 11:
(ResultSCE – ResultSCD) × (1 + Rwire / Rcomp)
where

ResultSCE = result with shunt calibration enabled
ResultSCD = result with shunt calibration disabled
Rwire = wire resistance measured in step 1
Rcomp = 120 Ω for the NI 9235 and 350 Ω for the NI 9236

© National Instruments Corporation
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15. Compare the final result to the Upper Limit (μV/V) and Lower Limit
(μV/V) values in Table 7. If the result is between these values, the
device passes the test.
You can analyze data in V/V form or convert it to strain using the standard
quarter-bridge equation:

Note

–4 × Vr
strain ( ε ) = ------------------------------------------GF ( 1 + ( 2 × V r ) )
where Vr is the compensated reading from the NI 9235/9236 and GF is a gage factor of 2.
16. Repeat steps 3 through 15 for all channels.
17. Set the calibrator to standby mode (STBY).
18. Disconnect the calibrator from the device.

Excitation Voltage Verification
The excitation source of the NI 9235/9236 is common to all eight input
channels so you need to verify excitation voltage on only one channel.
Complete the following steps to verify the excitation voltage:
1.

Connect the positive input of the DMM to any EXC terminal of the
module and the negative input of the DMM to any RC terminal of the
module. Leave all other terminals unconnected.

2.

Measure the DC voltage and compare it to the Lower Limit and Upper
Limit values in Table 8. If the result is between these values, the device
passes the test.

3.

Disconnect the DMM from the device.
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Specifications
The values in the following table are based on calibrated scaling
coefficients, which are stored in the onboard EEPROM. The following
calibration specifications are for 23 ±5 °C.
Table 2. NI 9235/9236 Measurement Accuracy

Module

Percent of Reading
(Gain Error)

Percent of Range*
(Offset Error)

NI 9235/9236

0.04% max

0.002% max

* Range equals 29.4 mV/V.

Table 3. NI 9235/9236 Shunt Calibration Accuracy

Module

Percent of Reading (Gain Error)

NI 9235

0.22% max

NI 9236

0.20% max

Table 4. NI 9235/9236 Excitation Voltage Accuracy

© National Instruments Corporation

Module

Accuracy

NI 9235/9236

±1% max
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Test Limits
The following definitions describe how to use the information from
Tables 5 through 8.

Calibrator Output
The Calibrator Output is the calibrator resistance output entered for
verification.

Nominal Value
The Nominal Value is the approximate value that the module should read,
given the corresponding calibrator output.

1-Year Limits
The 1-Year Limits column contains the Upper Limits and Lower Limits for
the test results. That is, when the device is within its 1-year calibration
interval, the test results should fall between these upper and lower limit
values.
For accuracy verification, Upper Limits and Lower Limits are given in units
of V/V for verification and units of με for reference.
Table 5. NI 9235 Measurement Accuracy Verification Test Limits

1-Year Limits
Calibrator
Output
(Ω)

Nominal
Value
(V/V)

Nominal
Value
(με)

Lower
Limit
(V/V)

Upper
Limit
(V/V)

Lower
Limit
(με)

Upper
Limit
(με)

120

0

0

—

—

—

—

108

0.0263158

–50,000

0.0263048

0.0263268

–49,980.1

–50,019.9

114

0.0128205

–25,000

0.0128149

0.0128261

–24,989.3

–25,010.7

117

0.0063291

–12,500

0.0063261

0.0063321

–12,494.1

–12,505.9

123

–0.0061728

12,500

–0.0061698

–0.0061758

12,493.8

12,506.0

126

–0.0121951

25,000

–0.0121897

–0.0122005

24,988.7

25,011.3

132

–0.0238095

50,000

–0.0237995

–0.0238195

49,977.8

50,022.1

Note: The Upper and Lower Limit (V/V) values are commonly used for verification. The Upper and Lower Limit (με) values
are for reference.
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Table 6. NI 9236 Measurement Accuracy Verification Test Limits

1-Year Limits
Calibrator
Output
(Ω)

Nominal
Value
(V/V)

Nominal
Value
(με)

Lower
Limit
(V/V)

Upper
Limit
(V/V)

Lower
Limit
(με)

Upper
Limit
(με)

350

0

0

—

—

—

—

315

0.0263158

–50,000

0.0263048

0.0263268

–49,980.1

–50,019.9

332.5

0.0128205

–25,000

0.0128149

0.0128261

–24,989.3

–25,010.7

341.25

0.0063291

–12,500

0.0063261

0.0063321

–12,494.1

–12,505.9

358.75

–0.0061728

12,500

–0.0061698

–0.0061758

12,493.8

12,506.0

367.5

–0.0121951

25,000

–0.0121897

–0.0122005

24,988.7

25,011.3

385

–0.0238095

50,000

–0.0237995

–0.0238195

49,977.8

50,022.1

Note: The Upper and Lower Limit (V/V) values are commonly used for verification. The Upper and Lower Limit (με) values
are for reference.

Table 7. NI 9235/9236 Shunt Calibration Accuracy Verification Test Limits

1-Year Limits

Module

Nominal
Value
(μV/V)

Nominal
Value
(με)

Lower
Limit
(μV/V)

Upper
Limit
(μV/V)

Lower
Limit
(με)

Upper
Limit
(με)

NI 9235

–599.28

1200.0

–597.96

–600.60

1197.3

1202.7

NI 9236

–873.47

1750.0

–871.72

–875.22

1746.5

1753.5

Note: The Upper and Lower Limit (μV/V) values are commonly used for verification. The Upper and Lower Limit (με)
values are for reference.

Table 8. NI 9235/9236 Excitation Voltage Verification 1-Year Test Limits
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Module

Lower Limit (V)

Upper Limit (V)

NI 9235

1.980

2.020

NI 9236

3.267

3.333
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Where to Go for Support
The National Instruments Web site is your complete resource for technical
support. At ni.com/support you have access to everything from
troubleshooting and application development self-help resources to email
and phone assistance from NI Application Engineers.
National Instruments corporate headquarters is located at
11500 North Mopac Expressway, Austin, Texas, 78759-3504.
National Instruments also has offices located around the world to help
address your support needs. For telephone support in the United States,
create your service request at ni.com/support and follow the calling
instructions or dial 512 795 8248. For telephone support outside the United
States, contact your local branch office:
Australia 1800 300 800, Austria 43 662 457990-0,
Belgium 32 (0) 2 757 0020, Brazil 55 11 3262 3599,
Canada 800 433 3488, China 86 21 5050 9800,
Czech Republic 420 224 235 774, Denmark 45 45 76 26 00,
Finland 358 (0) 9 725 72511, France 01 57 66 24 24,
Germany 49 89 7413130, India 91 80 41190000, Israel 972 3 6393737,
Italy 39 02 41309277, Japan 0120-527196, Korea 82 02 3451 3400,
Lebanon 961 (0) 1 33 28 28, Malaysia 1800 887710,
Mexico 01 800 010 0793, Netherlands 31 (0) 348 433 466,
New Zealand 0800 553 322, Norway 47 (0) 66 90 76 60,
Poland 48 22 328 90 10, Portugal 351 210 311 210,
Russia 7 495 783 6851, Singapore 1800 226 5886,
Slovenia 386 3 425 42 00, South Africa 27 0 11 805 8197,
Spain 34 91 640 0085, Sweden 46 (0) 8 587 895 00,
Switzerland 41 56 2005151, Taiwan 886 02 2377 2222,
Thailand 662 278 6777, Turkey 90 212 279 3031,
United Kingdom 44 (0) 1635 523545

CVI, LabVIEW, National Instruments, NI, ni.com, the National Instruments corporate logo, and the
Eagle logo are trademarks of National Instruments Corporation. Refer to the Trademark Information at
ni.com/trademarks for other National Instruments trademarks. The mark LabWindows is used
under a license from Microsoft Corporation. Windows is a registered trademark of Microsoft
Corporation in the United States and other countries. Other product and company names mentioned
herein are trademarks or trade names of their respective companies. For patents covering
National Instruments products/technology, refer to the appropriate location: Help»Patents in your
software, the patents.txt file on your media, or the National Instruments Patent Notice
at ni.com/patents.
© 2009–2010 National Instruments Corporation. All rights reserved.

372620B-01

May10

